Technical Contacts

<table>
<thead>
<tr>
<th>Topic</th>
<th>Contact</th>
</tr>
</thead>
<tbody>
<tr>
<td>Algorithm and HDF product</td>
<td>Louis Giglio (<a href="mailto:lgiglio@umd.edu">lgiglio@umd.edu</a>)</td>
</tr>
<tr>
<td>GeoTIFF and Shapefile product</td>
<td>Michael Humber (<a href="mailto:mhumber@umd.edu">mhumber@umd.edu</a>)</td>
</tr>
<tr>
<td>Product validation</td>
<td>Luigi Boschetti (<a href="mailto:luigi@uidaho.edu">luigi@uidaho.edu</a>)</td>
</tr>
</tbody>
</table>

Abbreviations and Acronyms

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BA</td>
<td>Burned Area</td>
</tr>
<tr>
<td>CMG</td>
<td>Climate Modeling Grid</td>
</tr>
<tr>
<td>EOS</td>
<td>Earth Observing System</td>
</tr>
<tr>
<td>EOSDIS</td>
<td>EOS Data Information System</td>
</tr>
<tr>
<td>GeoTIFF</td>
<td>Georeferenced Tagged Image File Format</td>
</tr>
<tr>
<td>HDF</td>
<td>Hierarchical Data Format</td>
</tr>
<tr>
<td>LP-DAAC</td>
<td>Land Processes Distributed Active Archive Center</td>
</tr>
<tr>
<td>MODIS</td>
<td>Moderate Resolution Imaging Spectroradiometer</td>
</tr>
<tr>
<td>SDS</td>
<td>Science Data Set</td>
</tr>
<tr>
<td>QA</td>
<td>Quality Assessment</td>
</tr>
</tbody>
</table>

Document Change History

<table>
<thead>
<tr>
<th>Revision</th>
<th>Date</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0</td>
<td>11/2016</td>
<td>Original version.</td>
</tr>
<tr>
<td>1.1</td>
<td>6/2018</td>
<td>Added CMG product information.</td>
</tr>
<tr>
<td>1.2</td>
<td>8/2018</td>
<td>Updated URLs and b1 server instructions.</td>
</tr>
<tr>
<td>1.3</td>
<td>12/2020</td>
<td>Updated URLs and fuoco server download instructions. Corrected Equations (5) and (6). Added brief validation section and discussion of August 2020 Aqua outage.</td>
</tr>
</tbody>
</table>

Title page image: *MCD64A1 cumulative area burned in the Central African Republic and South Sudan during the 2004–2005 burning season.*
## Contents

1 Introduction  
1.1 Summary of Collection 6 Algorithm and Product Changes .................................. 5  
1.2 Terminology ........................................................................................................ 5  
1.2.1 Granules ........................................................................................................ 5  
1.2.2 Tiles .............................................................................................................. 5  
1.2.3 Climate Modeling Grid (CMG) ...................................................................... 6  
1.2.4 Collections ..................................................................................................... 6  

2 MCD64A1 Algorithm Summary ............................................................................. 7  

3 MCD64 Product Suite ......................................................................................... 7  
3.1 Level 3 Monthly Tiled Product: MCD64A1 ...................................................... 7  
3.1.1 Naming Convention ................................................................................... 7  
3.1.2 Data Layers ............................................................................................... 9  
3.1.3 Metadata ................................................................................................... 10  
3.1.4 Example Code .......................................................................................... 11  
3.2 GeoTIFF subset for GIS visualization and analysis: MCD64monthly .......... 15  
3.2.1 Naming Convention ................................................................................... 15  
3.2.2 Example Code .......................................................................................... 16  
3.3 Shapefile subset for GIS visualization and analysis: MCD64monthly .......... 17  
3.3.1 Naming Convention ................................................................................... 17  
3.4 MCD64CMQ Climate Modeling Grid Burned Area Product ....................... 18  
3.4.1 Naming Convention ................................................................................... 18  
3.4.2 Global Grid ............................................................................................... 18  
3.4.3 Data Layers ............................................................................................... 18  
3.4.4 Metadata ................................................................................................... 19  
3.4.5 Example Code .......................................................................................... 20  

4 Obtaining the MODIS Burned Area Products .................................................. 22  
4.1 Downloading the products from the fuoco SFTP server ............................ 22  
4.1.1 HDF Files ................................................................................................. 23  
4.1.2 GeoTIFF files and Shapefiles .................................................................. 23  
4.1.3 Example sftp command line session ......................................................... 24  

5 Working with the product in ENVI 4.8 .............................................................. 25  
5.1 MCD64A1 (HDF) ......................................................................................... 25  
5.2 MCD64monthly (GeoTIFF) .......................................................................... 25  
5.3 MCD64monthly (Shapefile) .......................................................................... 25  

6 Working with the product in ArcGIS ................................................................. 25  
6.1 MCD64monthly (GeoTIFF) .......................................................................... 25  
6.1.1 Area of Interest (AoI) ............................................................................. 26  
6.2 MCD64monthly (Shapefile) .......................................................................... 26  

7 Validation of the MODIS Burned Area Product ............................................. 28
8 Known Problems
8.1 Cropland Burning .......................................................... 28
8.2 August 2000 and June 2001 Data Outages ............................. 28
  8.2.1 August 2020 Aqua Outage ........................................... 29

9 Frequently Asked Questions ................................................. 29

10 References ........................................................................... 30

11 Relevant Web and FTP Sites ................................................... 31

Appendix A Coverage of the GeoTIFF subsets ................................... 32

Appendix B Coordinate conversion for the MODIS sinusoidal projection
  B.1 Forward Mapping .............................................................. 33
  B.2 Inverse Mapping ............................................................... 33
  B.3 Applicability to 250-m and 1-km MODIS Products ................... 34

List of Tables
  1 Sizes of grid cells in Level 3 tiled MODIS sinusoidal grid. ............... 6
  2 Day-of-year of the first day of each calendar month. ......................... 8
  3 MCD64A1 metadata stored as standard global HDF attributes. ........... 10
  4 MCD64CMQ metadata stored as standard global HDF attributes. ......... 19
  5 Regions and bounding coordinates of the GeoTIFF subsets. ............... 32

List of Figures
  1 MODIS tiling scheme. ......................................................... 6
  2 Coverage of the GeoTIFF subsets. ........................................... 15
  3 Display of GeoTIFF from August 2010, Window 20. ....................... 26
  4 ArcGIS export raster window. .............................................. 27
  5 MCD64monthly Shapefile superimposed over Landsat image. ............ 27
  6 Representative Direct Broadcast coverage during 2020 Aqua outage. .... 29
1 Introduction

This document contains the most current information about the Collection 6 Moderate Resolution Imaging Spectroradiometer (MODIS) Burned Area product suite. It is intended to provide the end user with practical information regarding the use (and misuse) of the products, and to explain some of the more obscure and potentially confusing aspects of the burned area products and MODIS products in general.

1.1 Summary of Collection 6 Algorithm and Product Changes

1. The product is now generated using an improved version of the Giglio et al. (2009) MCD64 burned area mapping algorithm (i.e., MCD64A1 will be adopted as the standard MODIS burned area product for Collection 6). The MCD45A1 product will not be generated beyond Collection 5.1.

2. The product is generated using Collection 6 (versus Collection 5) surface reflectance and active fire input data.

3. General improvement (reduced omission error) in burned area detection.

4. Significantly better detection of small burns.

5. Modest reduction in burn-date temporal uncertainty.

6. Significant reduction in the occurrence of unclassified grid cells due to algorithm changes and refinements in the upstream Collection 6 input data.

7. Product coverage expanded from 219 to 268 MODIS tiles.

8. Expanded per-pixel quality assurance (QA) product layer.

9. MCD64A1 Burn Date layer now uniquely flags missing-data versus water grid cells.

1.2 Terminology

Before proceeding with a description of the MCD64 burned area products, we briefly define the terms granule, tile, climate modelling grid, and collection in the context of these products.

1.2.1 Granules

A granule is an unprojected segment of the MODIS orbital swath containing about 5 minutes of data. MODIS Level 0, Level 1, and Level 2 products are granule-based.

1.2.2 Tiles

MODIS Level 2G, Level 3, and Level 4 products are defined on a global 250-m, 500-m, or 1-km sinusoidal grid (the particular spatial resolution is product-dependent). Because these grids are unmanageably large in their entirety (43200 × 21600 pixels at 1 km, and 172800 × 86400 pixels at 250 m), they are divided into fixed tiles approximately 10° × 10° in size. Each tile is assigned a horizontal (H) and vertical (V) coordinate, ranging from 0 to 35 and 0 to 17, respectively (Figure 1). The tile in the upper left (i.e. northernmost and westernmost) corner is numbered (0,0).
Note that the Level 3 MODIS products generated on the MODIS sinusoidal grid are colloquially referred to as having “1 km”, “500 m”, and “250 m” grid cells. The exact cell sizes are shown in Table 1.

Table 1: Sizes of grid cells in Level 3 tiled MODIS sinusoidal grid.

<table>
<thead>
<tr>
<th>Colloquial Size</th>
<th>Actual Size (m)</th>
</tr>
</thead>
<tbody>
<tr>
<td>“1 km”</td>
<td>926.62543305</td>
</tr>
<tr>
<td>“500 m”</td>
<td>463.31271653</td>
</tr>
<tr>
<td>“250 m”</td>
<td>231.65635826</td>
</tr>
</tbody>
</table>

1.2.3 Climate Modeling Grid (CMG)

MODIS Level 3 and Level 4 products can also be defined on a coarser-resolution climate modelling grid (CMG). The objective is to provide the MODIS land products at consistent low resolution spatial and temporal scales suitable for global modeling. In practice, there is a fair amount of variation in the spatial and temporal gridding conventions used among the MODIS land CMG products.

1.2.4 Collections

Reprocessing of the entire MODIS data archive is periodically performed to incorporate better calibration, algorithm refinements, and improved upstream data into all MODIS products. The updated MODIS data archive resulting from each reprocessing is referred to as a collection. Later collections supersede all earlier collections.

Neither the MCD45A1 nor MCD64A1 MODIS burned area product were produced in Collections 1 through 4. Both products were produced for the first time as part of Collection 5. For Collection 6, only the MCD64A1 product is available.
2 MCD64A1 Algorithm Summary

The MCD64 burned-area mapping approach employs 500-m MODIS imagery coupled with 1-km MODIS active fire observations. The hybrid algorithm applies dynamic thresholds to composite imagery generated from a burn-sensitive vegetation index (VI) derived from MODIS short-wave infrared channels 5 and 7, and a measure of temporal texture. The VI is defined as

\[ VI = \frac{\rho_5 - \rho_7}{\rho_5 + \rho_7}, \]

where \( \rho_5 \) and \( \rho_7 \) are respectively the band 5 and band 7 atmospherically corrected surface reflectance. Cumulative active fire maps are used to guide the selection of burned and unburned training samples and to guide the specification of prior probabilities. The combined use of active-fire and reflectance data enables the algorithm to adapt regionally over a wide range of pre- and post-burn conditions and across multiple ecosystems. See Giglio et al. (2018) for a complete description of the algorithm.

The mapping algorithm ultimately identifies the date of burn, to the nearest day, for 500-m grid cells within the individual MODIS tile being processed. The date is encoded in a single data layer of the output product as the ordinal day of the calendar year on which the grid cell burned (range 1-366), with a value of 0 for unburned land grid cells and additional special values reserved for missing-data and water grid cells. The output product contains additional data layers for diagnostic purposes and to facilitate uncertainty propagation into downstream products derived from the burned area maps, such as emissions estimates.

3 MCD64 Product Suite

Three different versions of the MODIS burned area product are available:

- The official MCD64A1 product in HDF-EOS format, which is available as part of the MODIS suite of global land products.
- The re-projected monthly GeoTIFF version available from the University of Maryland.
- The re-projected monthly Shapefile version available from the University of Maryland.

3.1 Level 3 Monthly Tiled Product: MCD64A1

The MCD64A1 Burned Area Product is a monthly, Level-3 gridded 500-m product containing per-pixel burning and quality information, and tile-level metadata.

3.1.1 Naming Convention

The file naming convention, which has been adopted by all standard MODIS products, is as follows:

\[ \text{MCD64A1.AYYYYDDD.hHHvVV.006.PPPPPPPPPPPPP.hdf} \]

where

- \( YYYY \) = year mapped
- \( DDD \) = start day-of-year (Julian day) of calendar month in which burns have been mapped (Table 2)
- \( HH \) = horizontal tile coordinate on MODIS sinusoidal grid

Table 2: Day-of-year (DOY) of the first day of each calendar month. The **DDD** field (see above) in the file names of the MCD64 products will always have one of the 22 unique values shown here.

<table>
<thead>
<tr>
<th>Month</th>
<th>Non-Leap Year</th>
<th>Leap Year</th>
</tr>
</thead>
<tbody>
<tr>
<td>January</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>February</td>
<td>32</td>
<td>32</td>
</tr>
<tr>
<td>March</td>
<td>60</td>
<td>61</td>
</tr>
<tr>
<td>April</td>
<td>91</td>
<td>92</td>
</tr>
<tr>
<td>May</td>
<td>121</td>
<td>122</td>
</tr>
<tr>
<td>June</td>
<td>152</td>
<td>153</td>
</tr>
<tr>
<td>July</td>
<td>182</td>
<td>183</td>
</tr>
<tr>
<td>August</td>
<td>213</td>
<td>214</td>
</tr>
<tr>
<td>September</td>
<td>244</td>
<td>245</td>
</tr>
<tr>
<td>October</td>
<td>274</td>
<td>275</td>
</tr>
<tr>
<td>November</td>
<td>305</td>
<td>306</td>
</tr>
<tr>
<td>December</td>
<td>335</td>
<td>336</td>
</tr>
</tbody>
</table>

---

1. This naming convention ensures that files always have a unique name: if a tile is reprocessed the last number, indicating the day and time in which the file was processed, will be different, thus avoiding any confusion with obsolete data.
3.1.2 Data Layers

The product contains five data layers (Burn Date, Burn Date Uncertainty, QA, First Day, and Last Day), each stored as a separate HDF4 Scientific Data Set (SDS).

**Burn Date:** Ordinal day of burn (1-366) for each 500-m grid cell, with 0 = unburned land, -1 = unmapped due to insufficient data, and -2 = water.

**Burn Date Uncertainty:** Estimated uncertainty in date of burn, in days. Unburned and unmapped grid cells will always have a value of 0 in this layer.

**QA:** 8-bit quality assurance bit field.

  - **bit 0:** 0 = water grid cell, 1 = land grid cell.
  - **bit 1:** Valid data flag (0 = false, 1 = true). A value of 1 indicates that there was sufficient valid data in the reflectance time series for the grid cell to be processed. (NB. Water grid cells will always have this bit clear.)
  - **bit 2:** Shortened mapping period (0 = false, 1 = true). This flag indicates that the period of reliable mapping does not encompass the full one-month product period, i.e., burns could not be reliably mapped over the full calendar month.
  - **bit 3:** Grid cell was relabeled during the contextual relabeling phase of the algorithm (0 = false, 1 = true).
  - **bit 4:** Spare bit set to 0.
  - **bits 5–7:** Special condition code reserved for unburned grid cells. This code provides an explanation for any grid cells that were summarily classified as unburned by the detection algorithm due to special circumstances.
    - **0:** None or not applicable (i.e., burned, unmapped, or water grid cell).
    - **1:** Valid observations spaced too sparsely in time.
    - **2:** Too few training observations or insufficient spectral separability between burned and unburned classes.
    - **3:** Apparent burn date at limits of time series.
    - **4:** Apparent water contamination.
    - **5:** Persistent hot spot.
    - **6:** Reserved for future use.
    - **7:** Reserved for future use.

**First Day** and **Last Day:** The First Day and Last Day SDSs indicate the first and last days, respectively, on which changes could be reliably detected within the time series, on a per-grid-cell basis. Note that during periods of persistent cloud cover or frequent data loss, these dates will often lie within the calendar month that was mapped, indicating that reliable mapping could not be achieved over the full month.
3.1.3 Metadata

As with standard MODIS products, the MCD64A1 product contains global metadata stored in the ECS CoreMetadata.0 and ArchiveMetadata.0 global attributes. For convenience, a subset of these metadata as well as additional metadata are stored as standard HDF global attributes (Table 3).

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BurnedCells</td>
<td>Number of burned 500-m land grid cells during product month.</td>
</tr>
<tr>
<td>MissingCells</td>
<td>Number of 500-m land grid cells during product month having too few valid observations for algorithm to function.</td>
</tr>
<tr>
<td>LandCells</td>
<td>Number of 500-m land grid cells in tile.</td>
</tr>
<tr>
<td>ValidLandCells</td>
<td>Number of 500-m land grid cells for which mapping could be performed.</td>
</tr>
<tr>
<td>ProductStartDay</td>
<td>Julian start day of product calendar month (range 1 – 336).</td>
</tr>
<tr>
<td>ProductEndDay</td>
<td>Julian end day of product calendar month (range 31 – 366).</td>
</tr>
<tr>
<td>year</td>
<td>Product year.</td>
</tr>
<tr>
<td>tile</td>
<td>Six-character tile descriptor, e.g., “h20v11”.</td>
</tr>
</tbody>
</table>
3.1.4 Example Code

Example 1: IDL code to read a global attribute and two SDSs in the MCD64A1 product.

```idl
mcd64al_file = 'MCD64A1.A2006213.h20v11.006.2016091211241.hdf'

sd_id = HDF_SD_START(mcd64al_file, /READ)

; read "BurnedCells" attribute
attr_index = HDF_SD_ATTRFIND(sd_id, 'BurnedCells')
HDF_SD_ATTRINFO, sd_id, attr_index, DATA=burned_cells

; convert 1-element vector to scalar
burned_cells = burned_cells[0]

index = HDF_SD_NAMETOINDEX(sd_id, 'Burn Date')
sds_id = HDF_SD_SELECT(sd_id, index)
HDF_SD_GETDATA, sds_id, burn_date
HDF_SD_ENDACCESS, sds_id

index = HDF_SD_NAMETOINDEX(sd_id, 'QA')
sds_id = HDF_SD_SELECT(sd_id, index)
HDF_SD_GETDATA, sds_id, QA
HDF_SD_ENDACCESS, sds_id

HDF_SD_END, sd_id

help, burned_cells, burn_date, QA
```

The code produces the following output:

```
BURNED CELLS LONG = 91474
BURN DATE INT = Array[2400, 2400]
QA BYTE = Array[2400, 2400]
```
Example 2: Python code to read the "Burn Date" and "QA" SDSs in the MCD64A1 product.

```python
import gdal
import numpy as np

in_file = "MCD64A1.A2006244.h31v10.006.2016091211913.hdf"

hdf_handle = gdal.Open(in_file)

# Print a list of all of the datasets within the hdf file
sds_list = hdf_handle.GetSubDatasets()
for sds in sds_list:
    print(sds)

# Open a subdataset "N" as an array with sds_list[N][0], values of N are:
# 0 = 'Burn Date', 1 = 'Burn Date Uncertainty', 2 = 'QA',
# 3 = 'First Day', 4 = 'Last Day'
burndate_handle = gdal.Open(sds_list[0][0])
burndate_data = burndate_handle.ReadAsArray()

qa_handle = gdal.Open(sds_list[2][0])
qa_data = qa_handle.ReadAsArray()

# Array can be handled with Numpy now
print(np.shape(burndate_data))
print(qa_data.dtype)

# Clean up when done
del qa_data, qa_handle, burndate_data, burndate_handle
```
Example 3: MATLAB code to read the MCD64A1 “Burn Date” SDS using the MATLAB routine `hdfread`. This is probably the easiest way to read individual HDF SDSs in MATLAB.

```matlab
mcd64a1_file = 'MCD64A1.A2006213.h20v11.006.2016091211241.hdf'
% read burn date layer in one shot
burn_date = hdfread(mcd64a1_file, 'Burn Date');
% display burn date (transposed so that North appears on top)
imagesc(burn_date.);
```

Example 4: Longer version of MATLAB code to read the MCD64A1 “Burn Date” layer. This is probably the better approach to use if multiple SDSs or multiple spatial subsets of an SDS will be read since the HDF file will be opened and closed only once. (The shorter approach using `hdfread` requires that the file be opened and closed for each read.)

```matlab
mcd64a1_file = 'MCD64A1.A2006244.h31v10.006.2016091211913.hdf'
sd_id = hdfsd('start', mcd64a1_file, 'DFACC_RDONLY');
sds_index = hdfsd('nametoindex', sd_id, 'Burn Date');
sds_id = hdfsd('select', sd_id, sds_index);
% prepare to read entire SDS (always 2400 x 2400 pixels in size)
start = [0,0];
edges = [2400,2400];
[burn_date, status] = hdfsd('readdata', sds_id, start, [], edges);
status = hdfsd('endaccess', sds_id);
status = hdfsd('end', sd_id);
% display burn date (transposed so that North appears on top)
imagesc(burn_date.);
```
Example 5: C code for reading MCD64A1 burn date layer using HDF library functions.

```c
#include <stdio.h>
#include <stdlib.h>
#include "mfhdf.h"

#define ROWS 2400
#define COLS 2400

main(int argc, char **argv)
{
    int32 sd_id, sds_index, sds_id;
    int32 rank, data_type, nattr, dim_sizes[MAX_VAR_DIMS];
    int32 start[2], int32 edges[2];
    char *infile;
    int i, j;
    long nburn;
    uint16 burn_date[ROWS][COLS];

    infile = "MCD64A1.A2006244.h31v10.006.2016091211913.hdf";

    if ((sd_id = SDstart(infile, DFACC_READ)) == FAIL) exit(1);
    start[0] = start[1] = 0;
    edges[0] = ROWS;
    edges[1] = COLS;

    if ((sds_index = SDnametoindex(sd_id, "Burn Date")) == FAIL) exit(2);
    if ((sds_id = SDselect(sd_id, sds_index)) == FAIL) exit(3);
    if (SDgetinfo(sds_id, (char *) NULL, &rank, dim_sizes, &data_type,
                  &nattr) == FAIL) exit(4);

    /* check rank and data type */
    if (rank != 2) exit(5);
    if (data_type != DFNT_UINT16) exit(6);

    if (SDreaddata(sds_id, start, NULL, edges, (void *) burn_date) == FAIL) exit(7);

    if (SDendaccess(sds_id) == FAIL) exit(8);
    if (SDend(sd_id) == FAIL) exit(9);

    /* simple example: count burned grid cells */
    nburn = 0L;
    for (i = 0; i < ROWS; i++) {
        for (j = 0; j < COLS; j++)
            if (burn_date[i][j] > 0) nburn++;
    }

    printf("%d burned grid cells.\n", nburn);
    exit(0);
}
```
3.2 GeoTIFF subset for GIS visualization and analysis: MCD64monthly

A user-friendly GeoTIFF version of the MCD64 product is derived from the standard MCD64A1 HDF version by University of Maryland. The GeoTIFF files are reprojected in Plate-Carrée projection and cover a set of sub-continental windows (Figure 2). A table containing the regions covered and bounding coordinates of the 24 windows is available in Appendix A.

![Figure 2: Coverage of the GeoTIFF subsets. A table of bounding coordinates is available in Appendix A.](image)

3.2.1 Naming Convention

The GeoTIFF files follow a naming convention similar to the official MCD64A1 product. However, as the GeoTIFF files are obtained by mosaicing, resampling, and reprojecting several tiles of the original product, the processing time is not available. Example product file names are:

MCD64monthly.A2000306.Win01.006.burndate.tif
MCD64monthly.A2000306.Win01.006.ba_qa.tif

where

MCD64monthly = monthly GeoTIFF version of MCD64A1
A2000306 = year and Julian date of the starting day of the month covered by the product: 306 is the Julian date of Nov 1, hence 2000306 means that the product covers November 2000.
Win01 = spatial extent: the file covers window 1 (Alaska)
006 = version identifier (Collection 6)
burndate/ba_qa = file content: unlike HDF, GeoTIFF files contain a single layer. Currently, two layers of the original product are available as GeoTIFF files: “Burn Date” and “QA”.
### 3.2.2 Example Code

**Example 6**: IDL code to read the GeoTIFF MCD64-monthly “Burn Date” product. Although not shown in this example, the IDL `QUERY_TIFF` function can be used to determine information about the GeoTIFF image without having to read it into memory.

```idl
infile = 'MCD64monthly.A2016183.Win13.006.burndate.tif'

; read entire image
burn_date = read_tiff(infile, GEOTIFF=geo)

; now read just a spatial subset
burn_date_subset = read_tiff(infile, SUB_RECT = [1000, 1000, 400, 400])

help, burn_date
help, burn_date_subset
help, geo, /STRUCT
```

The code produces the following output:

```
BURN_DATE      INT = Array[7055, 4552]
BURN_DATE_SUBSET
                INT = Array[400, 400]
** Structure <18147a8>, 10 tags, length=120, data length=114, refs=1:
  MODELPIXELSCALETAG  DOUBLE Array[3]
  MODELTIEPOINTTAG    DOUBLE Array[6, 1]
  GIMODELTYPEGEOKEY    INT 2
  GRASTERTYPEGEOKEY    INT 2
  GTCITATIONGEOKEY     STRING 'Geographic (Longitude, Latitude) Unspe'
  GEOGRAPHICTYPEGEOKEY INT 32767
  GEOGGEODETICDATUMGEOKEY INT 32767
  GEOGANGULARUNITSGEOKEY INT 9102
  GEOGSEMIMAJORAXISGEOKEY DOUBLE 0.0000000
  GEOGSEMIMINORAXISGEOKEY DOUBLE 0.0000000
```
3.3 Shapefile subset for GIS visualization and analysis: MCD64monthly

Shapefiles of the MCD64A1 *Burn Date* layer are derived from the monthly GeoTIFF files by the University of Maryland. The shapefiles are available with the same projection (Plate-Carrée) and geographic extent used for the GeoTIFF sub-continental windows (Figure 2).

3.3.1 Naming Convention

The shapefile naming convention is identical to the GeoTIFF naming convention. Each shapefile consists of multiple files which must remain in the same subdirectory. For convenience, shapefiles are distributed as a zipped tar archive file (".tar.gz") containing the four shapefile elements. MCD64monthly shapefile archives are named as follows:

MCD64monthly.A2000306.Win01.006.burndate.shapefiles.tar.gz

which in turn contains the following files:

MCD64monthly.A2000306.Win01.006.burndate.shp
MCD64monthly.A2000306.Win01.006.burndate.shx
MCD64monthly.A2000306.Win01.006.burndate.prj
MCD64monthly.A2000306.Win01.006.burndate.dbf

where

MCD64monthly = monthly shapefile version of MCD64A1
A2000306 = year and Julian date of the starting day of the calendar month covered by the product (here November 2000).
Win01 = spatial extent: the file covers window 1 (Alaska)
006 = version identifier (Collection 6)
burndate = file content.
3.4 MCD64CMQ Climate Modeling Grid Burned Area Product

The CMG burned area product is a gridded summary intended for use in regional and global modeling.

3.4.1 Naming Convention

The MCD64CMQ monthly product files follow the standard MODIS product naming convention. Examples:

- MCD64CMQ.A2003213.006.2017283041945.hdf  
  August 2003 product file
- MCD64CMQ.A2003214.006.2017283041945.hdf  
  August 2004 product file

3.4.2 Global Grid

Each data layer has 720 rows and 1440 columns comprising a global 0.25° grid. The center of the upper left grid cell is located at longitude 179.875°W, 89.875°N. One data layer has an additional dimension (i.e., it is three dimensional) as described below.

3.4.3 Data Layers

Each product file nominally contains four data layers (BurnedArea, QA, UnmappedFraction, and LandCoverDist), each stored as a separate HDF4 Scientific Data Set (SDS). Note that the LandCoverDist SDS will be absent from the most recent MCD64CMQ product files due to the ∼1-year forward production lag in the MCD12Q1 annual land cover product used to populate this layer. Such incomplete MCD64CMQ product files have a global string attribute named LandCoverNote and will be reprocessed when the relevant annual MCD12Q1 product becomes available.

- **BurnedArea**: Monthly area burned. The scaled values stored in this SDS must be multiplied by a factor of 0.01 to obtain burned area in hectares.
- **QA**: 8-bit quality assurance bit field. 0 = water, 1 = unprocessed land, 2 = processed land.
- **UnmappedFraction**: Combined spatial and temporal fraction of the unmapped land area within each grid cell [percent]. Specifically, this quantity is the average number of days that could be mapped during the one-month product period over all 500-m land grid cells falling within each 0.25° bin, divided by the number of days in the product calendar month. The resulting proportion is expressed as a percentage.
  
  Note that the unmapped fraction does not merely tally those 500-m grid cells in the MCD64A1 product classified as *unmapped* (such grid cells have a value of -1 in the MCD64A1 Burn Date SDS), for which the number of days mapped is zero. Rather, the quantity represents an average over *all* 500-m land grid cells, whether they are entirely unmapped, partially mapped due to a shortened mapping period (bit 2 set in the MCD64A1 QA SDS), or fully mapped during the product period.
  
  Unprocessed land grid cells (see QA layer above) will have an unmapped fraction of 100%.
- **LandCoverDist**: A breakdown (to the nearest percent) of the area burned in each grid cell by the 16 different UMD land cover classes available in the Collection 6 MCD12Q1 land cover product. These classes, which have been slightly modified for Collection 6, are shown below. The number in each row is the index into the specific plane of the three-dimensional LandCoverDist array that contains the percentage of the area burned for the corresponding land cover type.
0 water 8 woody savannas
1 evergreen needleleaf forests 9 savannas
2 evergreen broadleaf forests 10 grasslands
3 deciduous needleleaf forests 11 permanent wetlands
4 deciduous broadleaf forests 12 croplands
5 mixed forests 13 urban and built-up
6 closed shrublands 15 barren
7 open shrublands 16 unclassified

Note: The Collection 6 MCD12Q1 UMD land cover layer suffers from a bug that often assigns 500-m grid cells an invalid class value of 14 (the IGBP “cropland/natural vegetation mosaics” class). This incorrect class propagates into the MCD64CMQ product, and we therefore strongly advise users to ignore the LandCoverDist layer until the problem is corrected. In the interim all new C6 MCD64CMQ product files are being generated without the LandCoverDist layer. We will regenerate the MCD64CMQ product using the corrected Collection 6.1 MCD12Q1 product when it becomes available in 2021.

3.4.4 Metadata

File-level metadata are stored as global attributes in the HDF product files (Table 4).

Table 4: MCD64CMQ metadata stored as standard global HDF attributes.

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ShortName</td>
<td>Short name of product (“MCD64CMQ”).</td>
</tr>
<tr>
<td>Instrument</td>
<td>Instrument name (“MODIS”).</td>
</tr>
<tr>
<td>BinSize</td>
<td>Global grid bin size in degrees (0.25).</td>
</tr>
<tr>
<td>StartDate</td>
<td>Start date of monthly product to nearest second.</td>
</tr>
<tr>
<td>EndDate</td>
<td>End date of monthly product to nearest second.</td>
</tr>
<tr>
<td>NumInputBA</td>
<td>Number of MCD64A1 input files (nominally 268).</td>
</tr>
<tr>
<td>InputPointerBA</td>
<td>Comma-separated list of MCD64A1 input file names.</td>
</tr>
<tr>
<td>NumInputLC</td>
<td>Number of MCD12Q1 input files.</td>
</tr>
<tr>
<td>InputPointerLC</td>
<td>Comma-separated list of MCD12Q1 input file names.</td>
</tr>
<tr>
<td>LandCoverNote</td>
<td>String attribute present only in product files lacking the LandCoverDist SDS. Example value: “2018 MCD12Q1 product not available at time of processing”.</td>
</tr>
</tbody>
</table>

---

\(^2\)See https://landweb.modaps.eosdis.nasa.gov/cgi-bin/QS/new/pages.cgi?name=known_issues, case number PM_MCD12_19074.
3.4.5 Example Code

Example 7: IDL code to read the MCD64CMQ BurnedArea SDS.

```
pro cmg_demo
    COMPILE_OPT STRICTARR, STRICTARRSUBS

    mcd64cmq_file = 'MCD64CMQ.A2018001.006.2018149165520.hdf'

    sd_id = HDF_SD_START(mcd64cmq_file, /READ)

    index = HDF_SD_NAMETOINDEX(sd_id, 'BurnedArea')
    sds_id = HDF_SD_SELECT(sd_id, index)

    ; read SDS scale factor attribute
    attr_index = HDF_SD_ATTRFIND(sds_id, 'scale_factor')
    HDF_SD_ATTRINFO, sds_id, attr_index, DATA=scale_factor
    ; IDL returns scalar numeric attributes as a 1-element vector
    ; next line will convert it to a scalar
    scale_factor = scale_factor[0]

    ; read SDS units attribute
    attr_index = HDF_SD_ATTRFIND(sds_id, 'units')
    HDF_SD_ATTRINFO, sds_id, attr_index, DATA=units

    ; read scaled data
    HDF_SD_GETDATA, sds_id, ScaledAburn
    HDF_SD_ENDACCESS, sds_id

    HDF_SD_END, sd_id

    help, ScaledAburn, scale_factor, units

    Aburn = scale_factor * temporary(ScaledAburn)
    help, Aburn

    ; calculate total area burned worldwide
    Atotal = total(Aburn, /DOUBLE) ; ha

    print, Atotal/1.0e6, FORMAT='("Total burned area is",F6.2," Mha")
end
```

The code produces the following output:

```
SCALEDABURN LONG = Array[1440, 720]
SCALE_FACTOR FLOAT = 0.0100000
UNITS STRING = 'hectares'
ABURN FLOAT = Array[1440, 720]
Total burned area is 26.91 Mha
```
Example 8: IDL code to generate vectors containing the the latitude and longitude at the center of each 0.25° grid cell.

```idl
pro cmg_nav
  COMPILE_OPT STRICTARR, STRICTARRSUBS
  XGRID = 1440
  YGRID = 720
  bin_size = 0.25 ; degrees
  lat = (90.0 - bin_size/2) - bin_size * indicgen(YGRID) ; degrees
  lon = (-180.0 + bin_size/2) + bin_size * indicgen(XGRID) ; degrees
  ; print center latitude and longitude of first 24 rows/columns of grid
  help, lat
  print, lat[0:23], FORMAT='(8F9.3)'
  help, lon
  print, lon[0:23], FORMAT='(8F9.3)'
end
```

The code produces the following output:

<table>
<thead>
<tr>
<th>LAT FLOAT</th>
<th>Array[720]</th>
</tr>
</thead>
<tbody>
<tr>
<td>89.875</td>
<td>89.625</td>
</tr>
<tr>
<td>89.375</td>
<td>89.125</td>
</tr>
<tr>
<td>88.875</td>
<td>88.625</td>
</tr>
<tr>
<td>88.375</td>
<td>88.125</td>
</tr>
<tr>
<td>87.875</td>
<td>87.625</td>
</tr>
<tr>
<td>87.375</td>
<td>87.125</td>
</tr>
<tr>
<td>86.875</td>
<td>86.625</td>
</tr>
<tr>
<td>86.375</td>
<td>86.125</td>
</tr>
<tr>
<td>85.875</td>
<td>85.625</td>
</tr>
<tr>
<td>85.375</td>
<td>85.125</td>
</tr>
<tr>
<td>84.875</td>
<td>84.625</td>
</tr>
<tr>
<td>84.375</td>
<td>84.125</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>LON FLOAT</th>
<th>Array[1440]</th>
</tr>
</thead>
<tbody>
<tr>
<td>-179.875</td>
<td>-179.625</td>
</tr>
<tr>
<td>-179.375</td>
<td>-179.125</td>
</tr>
<tr>
<td>-178.875</td>
<td>-178.625</td>
</tr>
<tr>
<td>-178.375</td>
<td>-178.125</td>
</tr>
<tr>
<td>-177.875</td>
<td>-177.625</td>
</tr>
<tr>
<td>-177.375</td>
<td>-177.125</td>
</tr>
<tr>
<td>-176.875</td>
<td>-176.625</td>
</tr>
<tr>
<td>-176.375</td>
<td>-176.125</td>
</tr>
<tr>
<td>-175.875</td>
<td>-175.625</td>
</tr>
<tr>
<td>-175.375</td>
<td>-175.125</td>
</tr>
<tr>
<td>-174.875</td>
<td>-174.625</td>
</tr>
<tr>
<td>-174.375</td>
<td>-174.125</td>
</tr>
</tbody>
</table>

21
4 Obtaining the MODIS Burned Area Products

All MODIS products are available free of charge. The MODIS Burned Area Product is available for ordering from the Land Processes Distributed Active Archive Center (LP-DAAC). Additionally, a secure FTP (SFTP) server is maintained by the University of Maryland, primarily to assist science users who need to regularly download large volumes of data.

4.1 Downloading the products from the fuoco SFTP server

The MODIS burned area product is available for download in either HDF, GeoTIFF, or Shapefile format from the University of Maryland fuoco SFTP (formerly FTP) server. Connect using the following information:

Server: fuoco.geog.umd.edu
Login name: fire
Password: burnt

Note: As a consequence of our mandatory transition from FTP to SFTP\(^4\), most users will not be able to download product files using their regular web browser without first installing a third-party browser extension.

For downloading product files you can use the command-line sftp and lftp clients, or freely available GUI file transfer software such as FileZilla (https://filezilla-project.org) and Cyberduck (https://cyberduck.io/). SFTP-capable commercial software is also available and includes the examples listed below.

For Windows:
- SmartFTP (https://www.smartftp.com/)
- WinSCP (https://winscp.net)

For MacOS:
- ForkLift (https://binarynights.com/)
- Commander One (https://mac.eltima.com/file-manager.html)
- Transmit (https://panic.com/transmit/)
- Viper FTP (https://viperftp.com/)
- Flow (http://fivedetails.com/)

\(^3\)https://lpdaac.usgs.gov/
\(^4\)In our case the change in protocol was not driven by a need for encryption – here such a requirement would be pointless given that 1) the data are intended to be freely available and 2) we openly share the password – but instead to avoid various port-level server vulnerabilities associated with FTP.
Once connected, enter the data subdirectory to access the following abridged directory tree:

```
|-- GFED
|-- MODIS
 |  `-- C6
 |     |-- docs
 |     |-- MCD14ML
 |     |-- MCD64A1
 |     |  `-- HDF
 |     |     `-- h00v08, h00v09, ..., h35v10
 |     |     `-- SHP
 |     |          `-- Win01, Win02, ..., Win24
 |     |          `-- 2000, 2001, 2002, ...
 |     |     `-- TIFF
 |     |          `-- Win01, Win02, ..., Win24
 |     |          `-- 2000, 2001, 2002, ...
 |     |     |-- MCD64CMQ
 |     |          `-- Mx14CMQ
|-- VIIRS
 `-- VIIRS
```

### 4.1.1 HDF Files

As can be seen from the directory tree, the file system on this server is structured to organize the HDF MCD64A1 product hierarchically by tile. Specifically, all MCD64A1 HDF product files for a given tile are located in the directory `MODIS/C6/MCD64A1/HDF/hHHvVV`, where `HH` is the horizontal tile coordinate and `VV` is the vertical tile coordinate. For example, the Collection 6 MCD64A1 HDF files for MODIS tile h08v05 will be found in the directory `MODIS/C6/MCD64A1/HDF/h08v05`.

### 4.1.2 GeoTIFF files and Shapefiles

The layout of GeoTIFF files and Shapefiles on the server is structured to organize the data hierarchically by window, and then by year. All the data for the same window from the same year is located (for GeoTIFF files and shapefiles, respectively) in the directories `MODIS/C6/MCD64A1/TIF/WinXX/YYYY/` and `MODIS/C6/MCD64A1/SHP/WinXX/YYYY/`, where `XX` is the number of the window (Figure 2) and `YYYY` is the year. For example, the directory `MODIS/C6/MCD64A1/Win01/2001` contains all of the GeoTIFF files for the year 2001 for window 01 (Alaska).
4.1.3 Example sftp command line session

Here we use wildcards with the SFTP `get` command to download the January 2013 MCD64A1 HDF product for the entire globe (i.e., all 268 MODIS land tiles for which the product is produced).

$ sftp fire@fuoco.geog.umd.edu
Password:
Connected to fuoco.geog.umd.edu.
sftp> cd data
sftp> ls
GFED MODIS VIIRS VIRS
sftp> cd MODIS/C6/MCD64A1/HDF
sftp> progress
Progress meter disabled
sftp> get h??v??/MCD64A1.A2013001*
  Fetching /data/MODIS/C6/MCD64A1/HDF/h00v08/MCD64A1.A2013001.h00v08.006.2017...
  to MCD64A1.A2013001.h00v08.006.2017013041920.hdf
  Fetching /data/MODIS/C6/MCD64A1/HDF/h00v09/MCD64A1.A2013001.h00v09.006.2017...
  to MCD64A1.A2013001.h00v09.006.2017013052550.hdf
  Fetching /data/MODIS/C6/MCD64A1/HDF/h00v10/MCD64A1.A2013001.h00v10.006.2017...
  to MCD64A1.A2013001.h00v10.006.2017013041341.hdf
  .
  .
  Fetching /data/MODIS/C6/MCD64A1/HDF/h35v08/MCD64A1.A2013001.h35v08.006.2017...
  to MCD64A1.A2013001.h35v08.006.2017013053444.hdf
  Fetching /data/MODIS/C6/MCD64A1/HDF/h35v09/MCD64A1.A2013001.h35v09.006.2017...
  to MCD64A1.A2013001.h35v09.006.2017013053444.hdf
  to MCD64A1.A2013001.h35v10.006.2017013042434.hdf
sftp> bye
5 Working with the product in ENVI 4.8

5.1 MCD64A1 (HDF)

HDF MODIS products are only partially supported in ENVI. To open them, select File → Open External Files → Generic Formats → HDF. Opened as a generic HDF file, all geographic information is lost. To restore this information the projection parameters must be entered manually.

5.2 MCD64monthly (GeoTIFF)

The GeoTIFF files are fully compatible with ENVI. To open them, simply go through the File → Open Image File menu.

5.3 MCD64monthly (Shapefile)

Shapefiles are not directly supported in ENVI, rather they are converted to the ENVI Vector File (“.evf”) format during ingest. To load a shapefile, select Vector → Open Vector File and choose the Shapefile wildcard filter setting (“*.shp”). When prompted to set “Import Vector Files Parameters”, set the desired layer name and output file location and select “OK”. Do not adjust the projection information; the default values correspond to the Plate-Carrée projection used by the GeoTIFF files. Use the “Available Vectors List” (Vector → Available Vectors List) to overlay the vectors on an existing display, or display them in a new window.

6 Working with the product in ArcGIS

Handling HDF-EOS files is not straightforward in ArcGIS. We recommend that users of the standard HDF-EOS product perform any scientific analysis in other software packages (e.g., ENVI) and then export their output to ArcGIS in a different format such as GeoTIFF.

6.1 MCD64monthly (GeoTIFF)

The MCD64 GeoTIFF files can be directly loaded into ArcGIS through Add Layer. In order to display the burned areas only, under Layer Properties → Unique Values → Symbology set the color to “No Color” for the following Values:

- 0 - unburned
- -1 - missing data
- -2 - water

ArcGIS will display the burned area in Julian days of the given month in either individual colors or in the same color depending on your settings. An example is shown in Figure 3.
6.1.1 Area of Interest (AoI)

In order to reduce the file size of the regional GeoTIFF and focus on a specific region, an “area of interest (AoI)” spatial subset can be extracted.

1. Display desired AoI
2. Right mouse click data layer
3. Data → Export Data

The “Export Raster Data” window will open (Figure 4). Check both data frames options to Current and choose TIFF in the Format field.

6.2 MCD64monthly (Shapefile)

The Shapefiles can directly be loaded into ArcGIS via Add Layer. To change the appearance of the file, select Layer Properties → Symbology → Graduated Colors. Optionally, to remove the outlines of the data, right click a symbol in the Graduated Colors panel and select “Properties For All Symbols”, then set “Outline Color” to “No Color”. An example is shown in Figure 5.
Figure 4: ArcGIS export raster window.

Figure 5: Left: True-color (R, G, B) Landsat 7 scene acquired 20 October 2002 at path 98, row 71. Right: MCD64monthly October Shapefile superimposed over the burned area. Older burned areas are shown in blue tones, newer burns are shown in red tones.
7 Validation of the MODIS Burned Area Product

The Collection 6 product has been validated at Stage 3 by comparison with Landsat 8 Operational Land Imager (OLI) image pairs acquired 16 days apart that were visually interpreted. These independent reference data were selected using a stratified random sampling approach that allows for probability sampling of Landsat data in both time and in space. A total of 558 Landsat 8 OLI image pairs (1116 images), acquired between 1 March 2014 and 19 March 2015, were selected. Globally, the MCD64A1 product had an estimated 40.2% commission error and 72.6% omission error; the prevalence of omission errors is reflected by a negative estimated bias of the mapped global area burned relative to the Landsat independent reference data (-54.1%). Globally, the standard errors of the accuracy metrics were less than 6%. The product accuracy was also characterized at coarser scale using metrics derived from the regression between the proportion of coarse resolution grid cells detected as burned by MCD64A1 and the proportion mapped in the Landsat 8 interpreted maps. The errors of omission and commission observed at 30-m resolution compensate to a considerable extent at coarser resolution, as indicated by the coefficient of determination ($r^2 > 0.70$), slope ($> 0.79$) and intercept (-0.0030) of the regression between the MCD64A1 product and the Landsat independent reference data in 3-km, 4-km, 5-km, and 6-km coarse resolution cells. The analysis of the deviations between the proportion of area burned mapped by the MCD64A1 product and by the independent reference data, performed using 3-km × 3-km and 6-km × 6-km coarse resolution cells, indicates that the large negative bias in global area burned is primarily due to the systematic underestimation of smaller burned areas in the MCD64A1 product. Full details of the product validation may be found in Bochetti et al. (2016) and Boschetti et al. (2019).

8 Known Problems

8.1 Cropland Burning

Burned areas in cropland should generally be treated as low confidence due to the inherent difficulty in mapping agricultural burning reliably. See Hall et al. (2016) for more information about the complications unique to cropland-fire mapping.

8.2 August 2000 and June 2001 Data Outages

The monthly products for August 2000 and June 2001 are heavily degraded due to extended Terra MODIS outages.
8.2.1 August 2020 Aqua Outage

A failure of the Aqua formatter-multiplexer unit (FMU) on 16 August 2020 led to the loss of regular science data telemetry for a period of about two weeks. During this time the MODIS instrument remained otherwise functional, and an effort was made to generate the standard Aqua science products from Direct Broadcast Aqua MODIS data collected by Direct Readout ground stations around the world. A representative example of the limited Direct Broadcast coverage obtained during the outage is shown in Figure 6.

While essentially all Aqua science data over Africa, eastern Asia, Indonesia, and Oceana were lost during the two-week outage period, we do not expect the loss to significantly degrade the MCD64A1 burned area product in these regions since the Terra MODIS continued to function normally.

![Figure 6: Representative Direct Broadcast coverage available during the 16 August – 2 September 2020 Aqua FMU outage period, using the MODIS active fire (not burned area) product as an example. Fire pixels are shown in red, clear land pixels are shown in green, cloud pixels are shown in light blue, and areas lacking data are shown in white. Browse image courtesy of the LDOPE.](image-url)

9 Frequently Asked Questions

Is there an existing tool I can use to remap the tiled MODIS products into a different projection?

The now-defunct MODIS Reprojection Tool (MRT) and follow-on HDF-EOS to GeoTIFF Conversion Tool (HEG) can remap the tiled MODIS products into many different projections; see Section 11.
How do I calculate the latitude and longitude of a grid cell in the Level 3 products?

You can use the online MODLAND Tile Calculator\(^5\), or perform the calculation as described in Appendix B.

How do I calculate the tile and grid cell coordinates of a specific geographic location (latitude and longitude)?

You can use the online MODLAND Tile Calculator, or perform the calculation as described in Appendix B.

10 References


\(^5\)http://landweb.nascom.nasa.gov/cgi-bin/developer/tilemap.cgi
11 Relevant Web and FTP Sites

- **MODIS Fire and Thermal Anomalies**: General information about the MODIS Fire (Thermal Anomalies) and Burned Area products.
  https://modis-fire.umd.edu/

- **MODIS Land**: Information about the MODIS Land products.

- **MODIS Land Product Quality Assessment**: Product quality-assessment (QA) related information, including a very complete archive of known land-product issues with descriptions and examples.
  https://landweb.modaps.eosdis.nasa.gov/cgi-bin/QS/new/index.cgi

- **HEG: HDF-EOS to GeoTIFF Conversion Tool**: Software for reprojecting tiled HDF-EOS products into many different projections.
  https://wiki.earthdata.nasa.gov/display/DAS/HDF-EOS2+to+HDF-EOS5+Conversion+Tool

- **MODLAND Tile Calculator**: Online tool for performing forward and inverse mapping of MODIS sinusoidal tiles.
  http://landweb.nascom.nasa.gov/cgi-bin/developer/tilemap.cgi

- **NASA Earthdata Search**: The primary distribution site for most MODIS products. Formerly Reverb, and before that the Warehouse Inventory Search Tool (WIST), and before that the EOS Data Gateway (EDG).
  https://search.earthdata.nasa.gov/
### Appendix A  Coverage of the GeoTIFF subsets

Table 5: Regions and bounding coordinates of the GeoTIFF subsets.

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Alaska</td>
<td>-180</td>
<td>-140.5</td>
<td>50</td>
<td>70</td>
</tr>
<tr>
<td>2</td>
<td>Canada</td>
<td>-141</td>
<td>-50</td>
<td>40</td>
<td>70</td>
</tr>
<tr>
<td>3</td>
<td>USA (Conterminous)</td>
<td>-125</td>
<td>-65</td>
<td>23</td>
<td>50</td>
</tr>
<tr>
<td>4</td>
<td>Central America</td>
<td>-118</td>
<td>-58</td>
<td>7</td>
<td>33</td>
</tr>
<tr>
<td>5</td>
<td>South America (North)</td>
<td>-82</td>
<td>-34</td>
<td>-10</td>
<td>13</td>
</tr>
<tr>
<td>6</td>
<td>South America (Central)</td>
<td>-79</td>
<td>-34</td>
<td>-35</td>
<td>-10</td>
</tr>
<tr>
<td>7</td>
<td>South America (South)</td>
<td>-77</td>
<td>-54</td>
<td>-56</td>
<td>-35</td>
</tr>
<tr>
<td>8</td>
<td>Europe</td>
<td>-11</td>
<td>35</td>
<td>33</td>
<td>70</td>
</tr>
<tr>
<td>9</td>
<td>West and North Africa</td>
<td>-19</td>
<td>5</td>
<td>0</td>
<td>37.5</td>
</tr>
<tr>
<td>10</td>
<td>Central and North Africa</td>
<td>5</td>
<td>25</td>
<td>0</td>
<td>37.5</td>
</tr>
<tr>
<td>11</td>
<td>East Africa and Arabian Peninsula</td>
<td>25</td>
<td>65</td>
<td>0</td>
<td>37.5</td>
</tr>
<tr>
<td>12</td>
<td>Southern Africa (North)</td>
<td>8.5</td>
<td>48</td>
<td>-15</td>
<td>5.5</td>
</tr>
<tr>
<td>13</td>
<td>Southern Africa (South)</td>
<td>10</td>
<td>41</td>
<td>-35</td>
<td>-15</td>
</tr>
<tr>
<td>14</td>
<td>Madagascar</td>
<td>42</td>
<td>59</td>
<td>-27</td>
<td>-10</td>
</tr>
<tr>
<td>15</td>
<td>Russia and Central Asia 1</td>
<td>35</td>
<td>90</td>
<td>33</td>
<td>70</td>
</tr>
<tr>
<td>16</td>
<td>Russia and Central Asia 2</td>
<td>90</td>
<td>145</td>
<td>33</td>
<td>70</td>
</tr>
<tr>
<td>17</td>
<td>Russia (Kamchatka)</td>
<td>145</td>
<td>180</td>
<td>40</td>
<td>70</td>
</tr>
<tr>
<td>18</td>
<td>South Asia</td>
<td>60</td>
<td>93</td>
<td>5</td>
<td>36</td>
</tr>
<tr>
<td>19</td>
<td>South East Asia</td>
<td>90</td>
<td>155</td>
<td>-10</td>
<td>33</td>
</tr>
<tr>
<td>20</td>
<td>Australia</td>
<td>112</td>
<td>155</td>
<td>-45</td>
<td>-10</td>
</tr>
<tr>
<td>21</td>
<td>New Zealand</td>
<td>165</td>
<td>179</td>
<td>-48</td>
<td>-33</td>
</tr>
<tr>
<td>22</td>
<td>Azores</td>
<td>-31.6</td>
<td>-24.8</td>
<td>36.8</td>
<td>40</td>
</tr>
<tr>
<td>23</td>
<td>Cape Verde Island</td>
<td>-25.5</td>
<td>-22.5</td>
<td>14.6</td>
<td>17.5</td>
</tr>
<tr>
<td>24</td>
<td>Hawaii</td>
<td>-161</td>
<td>-154</td>
<td>18</td>
<td>24</td>
</tr>
</tbody>
</table>
Appendix B  Coordinate conversion for the MODIS sinusoidal projection

Navigation of the tiled MODIS products in the sinusoidal projection can be performed using the forward and inverse mapping transformations described here. We’ll first need to define a few constants:

\[ R = 6371007.181 \text{ m, the radius of the idealized sphere representing the Earth;} \]

\[ T = 1111950 \text{ m, the height and width of each MODIS tile in the projection plane;} \]

\[ x_{\text{min}} = -20015109 \text{ m, the western limit of the projection plane;} \]

\[ y_{\text{max}} = 10007555 \text{ m, the northern limit of the projection plane;} \]

\[ w = \frac{T}{2400} = 463.31271653 \text{ m, the actual size of a “500-m” MODIS sinusoidal grid cell.} \]

B.1  Forward Mapping

Denote the latitude and longitude of the location (in radians) as \( \phi \) and \( \lambda \), respectively. First compute the position of the point on the global sinusoidal grid:

\[ x = R\lambda \cos \phi \]

\[ y = R\phi. \]  

Next compute the horizontal (\( H \)) and vertical (\( V \)) tile coordinates, where \( 0 \leq H \leq 35 \) and \( 0 \leq V \leq 17 \) (Section 1.2.2):

\[ H = \left\lfloor \frac{x - x_{\text{min}}}{T} \right\rfloor \]

\[ V = \left\lfloor \frac{y_{\text{max}} - y}{T} \right\rfloor, \]

where \( \lfloor \rfloor \) is the floor function. Finally, compute the row (\( i \)) and column (\( j \)) coordinates of the grid cell within the MODIS tile:

\[ i = \left\lfloor \frac{(y_{\text{max}} - y) \mod T}{w} \right\rfloor \]

\[ j = \left\lfloor \frac{(x - x_{\text{min}}) \mod T}{w} \right\rfloor. \]

Note that for all 500-m MODIS products on the sinusoidal grid \( 0 \leq i \leq 2399 \) and \( 0 \leq j \leq 2399 \).

B.2  Inverse Mapping

Here we are given the row (\( i \)) and column (\( j \)) in MODIS tile \( H, V \). First compute the position of the center of the grid cell on the global sinusoidal grid:

\[ x = (j + 0.5)w + HT + x_{\text{min}} \]

\[ y = y_{\text{max}} - (i + 0.5)w - VT \]
Next compute the latitude \( \phi \) and longitude \( \lambda \) at the center of the grid cell (in radians):

\[
\phi = \frac{y}{R}, \quad \lambda = \frac{x}{R \cos \phi}.
\]

(9) \hspace{2cm} (10)

B.3 Applicability to 250-m and 1-km MODIS Products

With the following minor changes the above formulas are also applicable to the higher resolution 250-m and 500-m MODIS tiled sinusoidal products.

250-m grid: Set \( w = T/4800 = 231.65635826 \text{ m} \), the actual size of a “250-m” MODIS sinusoidal grid cell. For 250-m grid cells \( 0 \leq i \leq 4799 \) and \( 0 \leq j \leq 4799 \).

1-km grid: Set \( w = T/1200 = 926.62543305 \text{ m} \), the actual size of a “1-km” MODIS sinusoidal grid cell. For 1-km grid cells \( 0 \leq i \leq 1199 \) and \( 0 \leq j \leq 1199 \).